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Introduction

The Department of State publishes state administrative rules in the Rhode Island Regulations
Code of Regulations (RICR) as required by the State Administrative Procedure Act, 42-35. New
rules and amendments to existing rules are published on the Department of State’s website and

then later incorporated into the RICR and the Rhode Island Register published by LexisNexis.

Agencies use Rules and Regulations Database Submission Tool to file notice of proposed
rulemaking and final rules with the Department of State.

The RICR Template should be used in creating rules documents as it contains the “styles”
necessary to give rules documents a uniform look when published online. Styles are a set of
formatting characteristics such as font, indentation, and line spacing that can be quickly
applied to text to change the appearance. When the Department of State’s Administrative
Rules Staff updates the RICR, the Word styles allow your rules to display properly online.

That’'s why it is important to apply the appropriate RICR styles to all text in rules documents.

With little effort, you will be able to maintain the styles and style new text as you make changes
to your rules.

Contact us:

Call the Administrative Records Office staff if you need help creating documents or with the
Rules and Regulations Database Submission Tool.

Email: rulesreqgs@sos.ri.gov

Phone: 401-222-2353
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Guidelines to write your RICR document

Below are some guidelines and tips to help you create documents and apply styles using the

template:

The standard font to use for rules documents is Ariel size 10.

Use only the RICR-specific styles. After installing the RICR Template, you may see
additional styles in the drop-down list of styles, styles that Word has automatically
generated. Those additional styles do not affect the documents you create, but
remember, use only the RICR specific styles.

Do not use the Design ribbon in Word to apply styles to your document. Use the Styles
available in the Home ribbon.

To view examples of what the text looks like when the various styles are applied, see the
Examples of Styles in the RICR Template (p. 10) or the Example of Regulation in the

RICR Style (p. 11).
When you copy and paste text from an existing document, you can avoid introducing

additional styles by selecting “Paste Special” from the “Edit” menu, and then select
“Unformatted Text”, but this option will also remove Bold, Italics and Underlines.

No matter what “Title” level (heading level) the text of the rule falls under, whether the
text is under a Title 1 or a Title 4, always start the text of the rule using either the

‘RICR Paragraph 1’ or ‘RICR Heading 1’ style depending on whether it is a numbered or
an unnumbered paragraph.

You can review your Title structure by clicking “View” at the top of the document, then
checking “Navigation Pane”.

If you want the tables in your document to be searchable, create simple tables that can
appear within the rule text.

Call the Administrative Records Office staff if you need help creating documents or with
the Rules and Regulations Database Submission Tool.

Do’s and Don’ts

Please pay particular attention to the following:

Final rules files must be saved as a PDF file. This file must be created from the original
word processing document so that it is searchable.

Be sure to apply RICR styles to all text.

Use track changes or strike-out and small caps to indicate amendments in proposed
rules and redline documents.

Number rules and insert bullets manually. Turn off automatic numbering and bullets.
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* Tabs need to be inserted between the rule number and the text of the heading or

paragraph for proper alignment. You may insert an extra space for the tab to display

correctly.

» Use the paragraph styles to indent your paragraphs; do not use tabs for indentation.

» Do notinsert an additional hard return after a heading or a paragraph as the template

automatically inserts a line space when you start a new heading or paragraph.

RICR Template and MS Word Settings

Download the RICR Templates
* Download the RICR Template (RICR Template)

* Save the template on your local drive.
The RICR Template contains all the RICR styles necessary to format your document

correctly.

Display Style Area in the Document Window

You can quickly e - i
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e Change the “Style area width” to 1 inch and click OK at the bottom of the “Word
Options” window.

e You can change views at any time by clicking the “Draft View” icon in the “View”

menu at the top of the screen.
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Display Styles Window

Styles can also be applied from the “Styles” window. To display the Styles window:
e Click on the small arrow at the bottom right corner of the “Styles” block of the ribbon that
displays when you select the “Home” tab.

The “Styles” window will open to the right of your document.

RICR Template.cocx - Word

Bl Ient  Design  Loyout  References  Maifings  Review  View  Developer  PDF  Q Tell me what you want to dc

L sesseene AaBb! AaBbC AaBbC: AsBHCCD: AaBBCCD: An AQB aasvceo 1ascen
e "”HBIU,_‘! B--A- mphasis T Headieg 1 1 Heading 2 1 He 1 Norma wong " » tle

Turn off Auto Numbers and Auto Bullets

You may want to turn off auto-numbers and auto-bullets as both need to be manually keyed in
Rules documents. In Office 2010 and later (except Outlook):

* Click File

* Click Options

» Click Proofing

* Click AutoCorrect Options

* Select AutoFormat As You Type.

¢ Deselect “Automatic bulleted lists” and “Automatic numbered lists”.

Create Rules and Paste into RICR Template

Paste Rule Text into the RICR Template

* Open your rules document

* Select all the text (Ctrl + A) and copy (Ctrl + C)

* Close the document

* Navigate to the RICR Template saved on your local drive and open it

» Paste your text (Ctrl + V) into the new document

+ Save As an .rtf or .doc file with a new name

* You can now begin to type new text or copy and paste text from an existing document,

and then apply the RICR Template styles.
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Creating Rules Documents and Styling Text

Proposed Rules Document

Track Changes Method

To create a “Proposed Rules” document, you can use the Track Changes feature in Word or
“strike-out” and “small caps”. Track Changes can be found on the “Review” tab ribbon.
Select it to turn it on. After completing the changes save your document as an .rtf or a .doc
file. Now add your Notice of Proposed Rulemaking to the beginning of this document and
save your proposed rules packet as a .pdf for upload to the Rules and Regulations
Database Submission Tool.

Manual Method
Some agencies prefer not to use Track Changes and to manually create a redline (proposed
rules) document. To manually strikeout text:
» Select the text and then click on the bottom right corner of the “Font” block of the
“‘Home” tab ribbon
*  When the window opens, click the “Strikethrough” check-box and close the window
» Before typing new text to be inserted, open the “Font” window, click the check-box
next to “Small Caps” and close the window.
It may seem laborious to use small caps instead of using caps lock, but if you use this
method, both the stricken text and caps can be removed in minutes when you are ready to
create your final rules document. To make this process simpler, keyboard shortcuts or
toolbar buttons can be set up.

Final Rules Documents

Track Changes Method
After your hearing, you will need to create a “Final Rules” document, which is the clean copy
of the rules text with strikeouts and caps removed.
If you used Track Changes:
* Accept the changes and review the document to make sure all the changes appear
correctly.
» Save your document as a PDF file. The proposed rules document may be used as

the redline document, but may need to be modified after the hearing.
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Manual Method
If you manually created your Proposed Rules document:
» Use the “Replace” feature found on the “Home” tab ribbon to remove stricken
language.
» After opening the Replace window, place your cursor in the “Find what” field, select
the “More” button and then select “Format” and “Font”.
* When the “Font” window opens, select “Strikethrough” and click “OK”.
» Complete the process by selecting “Replace All” and close the window.
» All stricken text should now be removed.
+ To change the “Small caps” to normal font, select all text (Ctrl + A), select “Font”
under the “Edit” drop-down and deselect “Small caps” and close the window.
* All the text should now be changed to normal font.
* Review and proof your document for accuracy and save the file as an .rtf or a .doc
file for your records and a PDF for upload to the Rules and Regulations Database

Submission Tool.

Applying Styles to Text

Styles can be applied by displaying the Style Area Width to the left side and the Styles
Window to the right of your document.
To apply styles, use one of the following two methods:

Select a style and insert new text
» Choose the style you would like to use
* Type your text or insert Unformatted Text or Formatted Text (RTF) from another
document using “Paste Special’.
The style chosen applies to all text inserted from that point and forward.

REMEMBER: Pasting as “Unformatted Text” will remove all Bold, Italics and Underlines.

Apply a style to existing text
» Click anywhere in a paragraph or heading, or highlight (select) the text to be styled
* Click on the style you would like to apply
The style chosen applies to all text in the paragraph or heading up to the point of the first
hard return, or all highlighted or selected text, which allows you to select more than one

paragraph.
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REMEMBER: No matter what “Title” level (heading level) the text of the rule falls under, whether
the text is under a Title 1 or a Title 4, always start the text of the rule using the

‘RICR Paragraph 1’ style.

Numbered or Bulleted Paragraphs

For numbered paragraphs:
+ Select the ‘par’ style you would like to use, depending on the level of the paragraph.
* You will need to manually number paragraphs
* Type the rule number, insert a tab after the rule number
+ Type or insert the text of the paragraph.

For bulleted paragraphs:
» Select the ‘par’ style you would like to use, depending on the level of the paragraph.
* Insert a bullet and then type or paste in the text of the bulleted paragraph.
REMEMBER: Do not use Auto-Numbering or Auto-Bullets created in Word. All numbers or

bullets must be inserted manually.

Style a Table in Word

Create tables using Word’s Table feature found on the “Insert” tab. If possible, avoid using
partial borders. You can apply bold, underlining, and italics. You can also use merged cells and

shading in your tables.

Example of a simple table created in Word:

Short-Term Rating Category Examples Risk Weight (%)
Highest investment grade A-1, P-1 20

Second highest investment grade | A-2, P-2 50

Lowest investment grade A-3, P-3 100

Graphics

When filing documents with the Department of State you may leave maps and figures

embedded in your rules documents.
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Graphics and large tables can be presented in landscape view, for better appearance and
usability.

Troubleshooting Formatting Problems

Occasionally, when you open a document, the text may appear to have lost the styles you have
applied. If that happens, try Copying and Pasting into a new Template Document:

+ Select all the text (ctrl + A) and copy it (Ctrl + C)

* Close the document

* Navigate to the RICR Template saved on your local drive and open it

» Paste your text (Ctrl + V) into the new document

e Save As an .rtf or .doc file with a new name
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Examples of Styles in the RICR Template

REPLACE THIS TEXT WITH THE FULL RICR NUMBER (XX-RICR-XX-XX-X)

REPLACE THIS TEXT WITH THE RICR TITLE NUMBER - NAME (AGENCY
NAME)

REPLACE THIS TEXT WITH THE RICR CHAPTER NUMBER — NAME (FUNCTION)

REPLACE THIS TEXT WITH THE RICR SUBCHAPTER NUMBER, IF ASSIGNED (IF “00”
YOU MAY DELETE THIS LINE)

REPLACE THIS TEXT WITH THE RICR PART NUMBER — NAME (REGULATION)
[The suggested numbering and format below will help you create your new regulation. Replace each X’ with

the appropriate number for both rule numbers and statute citations, e.g. 21.1 Authority and 100-RICR-10-
5-1.1(a)(1)] — Delete this paragraph and any other extraneous text below.

x.1 Replace This Text with a Heading (Title 1)

x.1.1 Replace This Text with a Subheading (Title 2 — this heading level is optional)

A. Replace this text with Paragraph 1 — use the following subsections as appropriate
1. Replace this text with Paragraph 2 (subsection of Paragraph 1)
a. Replace this text with Paragraph 3 (subsection of Paragraph 2)

(1) Replace this text with Paragraph 4 (subsection of Paragraph 3)

x.2 Replace This Text with a Heading (Title 1)
x.3 Replace This Text with a Heading (Title 1)
x.4 Replace This Text with a Heading (Title 1)
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Example of Regulation in the RICR Style

260-RICR-10-00-1
TITLE 260 — DEPARTMENT OF ENVIRONMENTAL MANAGEMENT

CHAPTER 10 — AGRICULTURE AND RESOURCE MARKETING

PART 1 - RULES AND REGULATIONS FOR ENFORCEMENT OF THE FARM, FOREST, AND OPEN
SPACE ACT

1.1 Purpose

A. These rules establish requirements for implementation of the Farm, Forest, and Open Space Act. The
Department of Environmental Management, Divisions of Forest Environment and Agriculture in
cooperation with cities and towns are responsible for administering the program. These regulations will:

1. define properties eligible for inclusion;

2. set eligibility requirements;

3. specify standards for continued eligibility;

1.2 Authority

A. These rules and regulations are promulgated pursuant to Chapter 44-27 and sections 44-5-39 through
41 of the Rhode Island General Laws of 1956, as amended.

1.3 Findings and Policy

A. The findings and policies contained in RIGL Chapter 44-27, as amended, are hereby adopted as the
administrative findings and policy upon which these rules and regulations are base and are
enumerated below. These findings recognize and declare that it is the policy of the state that:

1. itisin the public interest to encourage the preservation of farm, forest, and open space land in order to
maintain a readily available source of food and farm products close to the metropolitan areas of the
state, to conserve the state’s natural resources, and to provide for the welfare and happiness of the
inhabitants of the state.

2. Thatitis in the public interest to prevent the forced conversion of farm, forest, and open space land to
more intensive uses as a result of economic pressures caused by the assessment for purposes of
property taxation at values incompatible with their preservation as farm, forest, and open space land.

3. That the necessity in the public interest of the enactment of the provisions of this chapter is a matter of
legislative determination.

1.4 Application

A. The terms and provisions of these Rules and Regulations shall be liberally construed to permit the
Department to effectuate the purposes of state law, findings and policies in accordance with the
following rules and regulations which establish eligibility.
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1.5

Definitions

For the purposes of these regulations, except as provided below, the following terms shall have the
following meanings:

"Agricultural operations" As used in this chapter, "agricultural operations" includes any commercial
enterprise which has as its primary purpose horticulture, viticulture, viniculture, floriculture, forestry,
stabling of horses, dairy farming, or aquaculture, or the raising of livestock, furbearing animals, poultry,
or bees.

“Actively devoted to agricultural or horticultural use” shall mean land used, under normally acceptable
practices, in the production of plants and animals useful to man including but not limited to: forages
and sod; fruits of all kinds including nuts, berries grapes and vegetables; floral, ornamental and
greenhouse products, the growing of Christmas trees; dairy animals and dairy products; poultry and
poultry products; sheep and sheep products; livestock including beef cattle, swine, horses and mules,
the stabling of horses; the commercial breeding or grazing of any or all such animals for the production
of meat, milk, fiber in saleable livestock; and the production of fish, shellfish, plant material and fish
products through aquacultural practices.

“Actively Managed” means forestland managed in accordance with the provisions of a written forest
stewardship plan for the enhancement of forest resources. (d) “Assessor” shall mean the appointed
individual or elected board, or other person or agency charged with the duty of assessing real property
in a municipality.

“Conservation Plan” means a written plan outlining Best Management Practices recommended by U.S.
Department of Agriculture and approved by the district and director. (f) “Director” means the Director of
the Rhode Island Department of Environmental Management or his/her authorized designee.

“District” shall mean the Conservation District organized under chapter 2-4 of RIGL.
“Department” shall mean the Rhode Island Department of Environmental Management.

“Farm, Forest and Open Space Land Value Subcommittee” shall be the subcommittee of the State
Conservation Committee established under chapter 2-4.3 of RIGL to recommend to the R.I.
Department of Administration to be transmitted to each city or town tax assessor the methodology and
values for the assessment of land for property taxation on the basis of current use for farm, forest and
open space lands as established by chapter 44-27 and 44-5-12 RIGL.

“Farmer” means the principal person engaged in agricultural operations as indicated for income tax
purposes.

“Farmland” means any tract(s) of land, exclusive of house site, that meets any one of the following
conditions and which has a current U.S. Department of Agriculture conservation plan, either applied for
or in force within the past 10 years;

a. Land which is actively devoted to “agricultural or horticultural use” as set forth in “agricultural
operations.”

b. Land which constitutes a “farm unit” which means land owned by the farmer, including
woodland and wetlands, at least (5) acres of which are actively devoted to agricultural and
horticultural use and which have produced an annual gross income from the sale of its farm
products of a least $2500.00 in one of the two preceding years.

c. Land thatis actively devoted to agricultural and horticultural use by a “Subsistence Farmer”
who derives his or her primary means of sustenance from the consumption of agricultural
products grown on their land. Non-farm related income must be low enough to make them
eligible for assistance under Title 20 Programs.
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11.

12.

13.

14.

15.

16.

1.6

d. Land which meets the qualifications for payments with the Federal Government for a
conservation set aside, or it has a combination of income, crop and acreage which in the
Director’s opinion qualifies this land for inclusion as a farm.

“Forestland” means any tract or contiguous tracts of land, ten (10) acres or larger, exclusive of house
site, bearing a dense growth of trees, including underbrush and young regenerating forest and ancillary
habitat areas having either the quality of self perpetuation, or being dependent upon its development
by the planting and replanting of trees in stands of closely growing timber, actively managed under a
stewardship plan approved by the director.

“Forest stewardship plan” or “management plan” means a plan prepared by a professionally qualified
forester, that incorporates landowner objectives into an action based plan for the purpose of enhancing
forest resources, which may include cultural operations to improve, where feasible and practical,
wildlife habitat, forest health, forest quality, watershed protection, soil stability, water quality protection,
aesthetics, the atmosphere, and passive non-commercial recreation. To qualify the plan must meet
minimum criteria established in the Appendix B.

“House site” means the zoned lot size or one acre, whichever is smaller containing a house, and land
under and surrounding dwellings or devoted to developed facilities, such as tennis courts, pools, etc.,
related to the use of the residence.

“Open space” or “Open space land” means any tract or contiguous tracts of undeveloped land, where
the undeveloped land serves to enhance agricultural values, or land in its natural state that conserves
forests, enhances wildlife habitat or protects ecosystem health, and that are:

a. ten (10) total acres or larger, exclusive of house site; or

b. tracts of land of any size that are designated as open space land in the town’s comprehensive
community plan; or

c. tracts of land of any size that have conservation restrictions or easements in full force.

“Owner” means the person recorded as the owner on the deed. (q) “Person” means any individual,
firm, corporation, co-operative, Limited Liability Company (LLC), natural person, trust, estate, non-
business entity, partnership, or other association or form of organization which can hold title to
personal or real property interests under Rhode Island law.

“Professionally Qualified Forester” shall mean a person who has graduated, with at least a Bachelor’s
degree in forestry, from a school recognized by the Society of American Foresters, or who possesses
equivalent qualifications approved by the director.

“Under Normally Acceptable Practices” shall mean management of the farm using cultivation and
husbandry techniques including but not limited to techniques for the proper animal and plant densities
and spacing, harvesting techniques, soil conditioning techniques, erosion control practices, waste
disposal techniques, cover crops, and rotation cycles recommended by the College of Resource
Development, University of Rhode Island, U.S. Department of Agriculture, recognized producers
organizations and seed and implement manufacturers for Rhode Island soils and practices approved
by the DEM Agricultural Advisory Committee.

Application for Designation of Farmland

An owner of land may file a written application with the director for its designation by the director as
farmland. When the application is made and after a filing fee of ten dollars ($10.00) is paid, the director
shall examine the land. If the director determines that the land is farmland, then the director shall issue
a certificate designating the land as farmland. The director shall furnish a copy of the certificate to the
owner of the land, and shall file one copy of the certificate in the office of the assessor of the city or
town in which the land is located.
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B. An owner of land designated as farmland by the director may also apply to the assessor of the city or
town where the land is located for its classification as farmland on any assessment list maintained by
the city or town. Pursuant to R.I.G.L. §44-27-3(c)(1), such an application must be filed with the
assessor of the city or town not earlier than thirty (30) days before nor later than thirty (30) days after
the date of assessment, except that in years of revaluation the application must be filed not later than
thirty (30) days after written notice of revaluation or in its absence after receipt of the tax bill. The
director’s designation of that land as farmland must be valid as of a date at or prior to the date of the
assessment. Pursuant to R.1.G.L. 844-27-3(d), the application must be made on a form prescribed by
the assessor and include a description of the land and the date of issuance of the director’s certificate
of designation.

C. Application to the director for designation as farmland shall be made upon forms prescribed by the
director and shall include a description of the land and any other information that may be required to
aid the director in determining whether the land qualifies for that designation and meets the minimum
criteria established in Appendix A (Application For Designation of Farmland or Forestland). For
continuing eligibility, the property is subject to re-inspection by the director every 5 years or at the
request of the tax assessor subject to the management recommendations prescribed by the plan and
approved by the director.

D. Pursuant to 844-27-2(1)(iii), farmland shall be taxed according to agricultural use based upon the
following four (4) categories:

1. Ornamental crops, including land devoted to floriculture, nursery and turf production, as well as land
under greenhouses:

2. Vegetable and Orchards, including small fruits, potatoes, cranberries, and Christmas trees:
3. Dairy and Livestock, including forage crops, hay, silage corn and grain, and aquaculture:
4. Forest and Wasteland which is part of the farm property.

E. Recommended values for farmland will be periodically determined by the Farm, Forest and Open
Space Land Value Subcommittee.

1.7 Application for Designation of Forestland

A. An owner of not less than ten (10) acres of land may file a written application with the director for its
designation by the director as forest land. When the application is made and a filing fee of ten dollars
($10.00) is paid, the director shall examine the land. If the director determines that the land is
forestland, then the director issues a certificate designating the land as forestland. The director shall
furnish a copy of the certificate to the owner of the land, and shall file a copy of the certificate in the
office of the assessor of the city or town in which the land is located.

B. An owner of land designated as forestland by the director may also apply to the assessor of the city or
town where the land is located for its classification as forestland on any assessment list maintained by
the city or town. Pursuant to R.I.G.L. 844-27-4(c)(1), such an application must be filed with the
assessor of the city or town not earlier than thirty (30) days before nor later than thirty (30) days after
the date of assessment, except that in years of revaluation not later than thirty (30) days after written
notice of revaluation or in its absence after receipt of the tax bill. The director’s designation of the land
as forest land must be valid as of a date at or prior to the date of the assessment. Pursuant to R.I.G.L.
844-27-4(d), the application must be made on a form prescribed by the assessor and include a
description of the land and the date of issuance of the director’s certificate of designation.

C. Pursuant to §844-27-2.2, 44-27-4(b) and 44-27-7, in order to maintain a certificate of designation for
forestland issued by the director, the landowner must update and submit a revised forest stewardship
plan at the end of each ten year period prepared by a professionally qualified forester meeting the
minimum criteria established in Appendix B. For continuing eligibility, the property is subject to re-
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1.8

1.9

inspection by the director every 5 years or at the request of the tax assessor and subject to the
management recommendations prescribed by the plan and approved by the director.

Application to the director for designation of land as forestland shall be made upon a form prescribed
by the director and shall include a description of the land and any other information that may be
required to aid the director in determining whether the land qualifies for that designation and meets the
minimum criteria established in Appendix A (Application For Farmland or Forestland). The application
shall be accompanied by a forest stewardship plan prepared by a qualified professional forester in
accordance with minimum criteria established in Appendix B.

Recommended values for forestland will be periodically determined by the Farm, Forest and Open
Space Land Value Subcommittee.

Application for Designation of Open Space Land

All applications for classification of land as open space must be made to the assessor of the city or
town where the land is located. The director is not authorized to designate open space land pursuant to
this act. Pursuant to R.1.G.L. 844-27-5, an owner of land may apply for its classification as open space
land on any assessment list of a city or town by filing a written application for that classification with the
assessor of the city or town, not earlier than thirty (30) days before nor later than thirty (30) days after
the date of assessment, except in years of revaluation when the landowner may file not later than thirty
(30) days after receiving written notice of revaluation or in its absence after receipt of the tax bill. The
assessor determines whether the land meets the definition of “open space” in these regulations and if
the assessor determines that it is open space, the assessor classifies the land as open space land and
includes it as open space on the assessment list.

Recommended values for open space will be periodically determined by the Farm, Forest and Open
Space Land Value Subcommittee.

Revocation of Farmland or Forestland Designation

When requested to do so by the assessor or whenever the director deems it necessary, the director
shall re-examine a farmland or forestland designation. If the director finds that the property no longer
qualifies as farmland or forestland, then the director shall act to revoke the certificate of designation.
Any action to revoke a certificate of designation shall be preceded by a notice to the owner of the land
in accordance with R.I.G.L. 842- 35-14(c) stating the facts or conduct that support revocation of the
certificate and providing the owner with a time within which to demonstrate compliance with the
requirements necessary to retain the farmland or forestland designation. If the owner fails to
demonstrate sufficient compliance to retain the farmland or forestland designation, then the director
shall initiate administrative proceedings pursuant to R.I.G.L. 842-17.1-2(u) to revoke certificate of
designation. Pursuant to R.I.G.L. §842- 17.7-9, 44-27-3(b) and 44-27-4(b), the notice of revocation
shall inform the owner that he/she has thirty (30) days to bring the land into compliance or to request a
formal administrative hearing.

Whenever a compliance order that finds that the land is no longer farmland or forestland shall become
effective, whether after the hearing or automatically after thirty (30) days where no hearing has been
requested, the director shall issue a certificate revoking the designation as per 844-27-3(b) and §44-
27-4(b). The certificate of revocation shall be issued in duplicate with one copy going to the landowner
and one copy being filed in the office of the assessor of the city or town in which the land is located.
Revocation of certificate of designation by action of the director makes the land subject to the land use
change tax pursuant to R.1.G.L. §44-5-39.
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1.10 Application for Designation of Open Space Land

A. The director may revoke a certificate designating land as farmland whenever the land is used in a
manner that is inconsistent with its management as farmland, including but not limited to situations
where:

1. The land remains unused for two(2) planting seasons for reasons other than federal (or state)
set asides.

2. Operations to strip topsoil or to mine sand or gravel or other minerals, other than for on-farm
uses, are undertaken on designated land.

3. Building permits for structures not directly related to the farm operation are obtained or
construction for such structure commences.

4, The procedures and schedule outlined in the Conservation Plan for the property are not
followed.

1.11 Criteria for Revocation of Designation of Forestland

A. The director may revoke a certificate designating land as forestland whenever the land is used in a
manner that is inconsistent with its management as forestland (e.g. campground or golf course)
including but not limited to situations where:

1. The procedures and schedule outlined in the forest stewardship plan for the property are not
followed.
2. Operations to strip topsoil or to mine sand or gravel or other minerals, other than for

improvements to subject forestlands, are undertaken on designated land.

3. Building permits for structures not directly related to the forest operation are obtained or
construction for such structure commences.

4, The procedures and schedule outlined in the Conservation Plan for the property are not
followed.

1.12 Appeals

A. Any person who has exhausted all administrative remedies available to him/her within the agency and
who is aggrieved by a final order of the director in a contested case may seek appellate review
pursuant to R.I.G.L. 842-35-15 of the Administrative Procedures Act, by filing a complaint in the
Superior Court within thirty (30) days after mailing of notice of the director’s final decision.

1.13 Severability

A. If any provision of these Rules and Regulations, or the application thereof to any person or
circumstances, is held invalid by a court of competent jurisdiction, the validity of the remainder of the
Rules and Regulations shall not be affected thereby.

1.14 Superseded Rules and Regulations

A. On the effective date of these Rules and Regulations, all previous Rules and Regulations, and any
policies regarding the administration and enforcement of the Farm, Forest, and Open Space Act filed
with the Secretary of State on October 2, 1980 shall be superseded. However, any enforcement action
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taken by, or application submitted to, the Department prior to the effective date of these Rules and
Regulations shall be governed by the Rules and Regulations in effect at the time the enforcement
action was taken, or application filed.
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